
WBIEG: How-to-tabulate-responses.doc Page 1 of 17 March 6, 2005 

How to use the Toolkit Template to  
TABULATE, conduct the ITEM ANALYSIS and SCORE  

the Level-2 Evaluation Results 
(For Assistants) 

 

I.  What you need to know/have to get started 

 
A. When to use the template and when NOT to use it: 

1. Once the participants have returned their completed pre- and post-test forms, you use the 
template. Your role is to enter the data into the template. Then, it will automatically conduct 
the item analysis and score the test.  

2. You can use the template for the tabulation of up to: 

¾ 50 multiple-choice test items (each with only one correct answer) on the pre-test; 

¾ 50 multiple-choice test items (each with only one correct answer) on the post-test; and 

¾ 254 respondents.  

3. If you are not in this case, the template would not work. You should use your own scoring 
means. (If all previous Toolkit guidelines were followed, you should be in this case, and you 
should use the template.) 

B. What you should have before starting: 

4. You should have all of the Pre-Test and Post-Test forms completed by your participants. (If 
you are missing a few forms that are expected to come later, you could tabulate your 
temporary results. When you receive the missing forms, you would enter their data and re-run 
the macro to get the final results.) If you want to get started before receiving the forms, you 
could go up to IV. 

5. Your computer should have Excel. (The template and the guidelines have been developed on 
Excel 2000. Theoretically, they should work with newer versions of Excel, but this was not 
fully tested.) 

C. How to use the Guidelines: 

6. Follow the instructions given in these guidelines in order.  

7.                  The green arrow over a picture, points to where to look/click. 

8. The sign  warns you against potential mistakes to avoid. Please follow the warnings or 
you could end up with inaccurate results or no results at all.    

9. The text within { } indicates how to perform the action with your computer.  

10. The text in italics indicates the situations in which you may find yourself. Only follow those 
that are relevant to you and skip the others.  

11. Unsure about the meaning of a term? Click the Level-2 Evaluation Toolkit Glossary of Terms. 

http://web.worldbank.org/WBSITE/EXTERNAL/WBI/0,,contentMDK:20270022~pagePK:209023~piPK:335094~theSitePK:213799,00.html
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II.  Download the template and create your tabulation file 

 
12. You need to download the tabulation template, a large Excel file that includes a macro. 

Depending on your Excel security settings, various warning windows may appear on your 
screen, as in the examples below. You may see other versions of these warnings. In any 
case, you should choose to enable the macro (i.e., allow the macro to be installed while you 
download and open the template). This macro only performs the item analysis and scoring of 
your test. It only appears when you use this template. It does not affect other files or macros. 

13. In Excel, pull down the “Tools” menu option, then click “Macro” and then select “Security...” A 
“Security” dialog box resembling the picture below will appear. If the Security Level is higher 
than Medium, set the Security Level to Medium by clicking the “Medium” radio button. Then 
click “OK.” You will return to your original security level after having enabled the macro, so 
remember your original security level. If your Security Level is Medium or lower, don’t change 
it, and Click OK. 

 
 
14. Close Excel (after saving every other file you may have open). 

15. Go to: Level-2 Evaluation Tabulation Template (by clicking the hyperlink of the current 
guidelines or the hyperlink on step 11 of the Toolkit’s list of Tools). Opening this 2.8 MB large 
template file may take several minutes. 

16. On opening the following dialog box may pop-up. If so, click “Yes” and skip to point 18 below. 

 

http://siteresources.worldbank.org/WBIINT/Resources/L2-Tabulation-Template-2004-06-15.xls
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17. Alternatively, on opening the following dialog box may pop-up. If so, click “Enable Macros.” 

 
 
18. The following window will open. Pull down the “File” menu and select “Save as...”  

 
19. Save the file in the directory of your choice and give it the name of your choice. In these 

guidelines, we will use the following name “My-Course-L2-Tabulation.xls” as an example. 
 
20. Close the Internet window (shown above) and open Excel. 
 
21. In Excel, open the file: “My-Course-L2-Tabulation.xls” (or whatever you named your file.) On 

opening a warning dialog box resembling those in points 16 and 17 above may pop-up. If so, 
click the option that would allow the macro to run. 

22. Now that you have accepted the macro, if you had changed you security level in point 13 
above, follow the same path to reset your security level as what it was before point 13. 
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III.  Get familiar with your tabulation file 

 
A. The toolbar: 

23. On opening, the following toolbar was loaded: . Typically 
it appears on the upper right corner of your screen. (If the icon:   is not on your screen, go 
back to Chapter II). The Toolkit toolbar includes the icons that perform the functions you may 
need during the tabulation.  

   Icon’s name: Function in tabulating your results 
 Item Analysis Macro: To computes your results. Use it after your entered all data. 
 Save: To save your document. (Use it often.) 
 Copy: To copy your selection. 
 Paste Values: To paste only the values you copied. (Use instead of regular paste.) 
 Insert Rows: To use only in “Table” sheet for formatting, if you want. 
 Page Break Preview: To adjust where the pages of the “Table” sheet breaks. 
 Print Preview: To preview your results on the “Table” sheet before printing. 
 Normal View: To display the normal view. 
 Print: To print your results. 

B. The worksheets: 

24. The workbook contains six visible sheets that you will use to tabulate your results: 
 

a. “Pre Data” In this sheet you will type or paste the pre-test items (stem and response 
options) and the participants results using 1 or 0, where 1 means the participant selected 
the option, and 0 if s/he did not select the option. 

b. “Post Data” In this sheet you will perform the same operations as above for the post-
test. 

c. “Table” This sheet presents the results. You may adjust its format slightly, if you wish. 
d. Blank sheet 1, 2, and 3. These sheets enable to paste your test items and adjust the 

layout safely without affecting the rest of the template 
 

 The template includes several hidden sheets. Please do not delete any sheet 
(hidden or visible) at any point because it would cause your results to disappear. Also, do not 
rename any sheet (hidden or visible) because the macro would not run. The only exceptions 
are “Blank sheet 1”, “Blank sheet 2”, and “Blank sheet 3” 

 
25. To move from one sheet to another, click the tab at the bottom of your screen that 

corresponds to the sheet that you want to see. You can identify which sheet you are using by 
the color of the tab. The sheet on which you can work has the same color as its tab (most 
often white). When you are not working on a sheet, its tab has a different color (most often 
gray).  

 
Picture of the Sheet Tabs 
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C. The frozen panes: 

26. To prevent data entry mistakes, the “Pre Data” and “Post Data” sheets use the “Freeze 
Panes” function.  

27. When you scroll down, the rows showing the respondent number and the participant codes 
remain visible, even if the first test items disappear from the screen. To view the latter rows 
again, scroll back up.  

28. When you scroll to the right, Column A that shows the items remains visible, even if the first 
respondents disappear from the screen. To view the latter columns again, scroll back to the 
left.  

D. The comments: 

29. When you place your cursor (without clicking) over a cell with a small red triangle on the 
upper right, a comment may pop-up, e.g., in cell A2 below. These are warnings or short 
instructions that you may use once you have tabulated results following these guidelines at 
least once. However, at least for your first time using the tabulation template, please follow 
the guidelines instead of the comments. The guidelines are more complete and will prevent 
you from making mistakes. 

 

E. The security features: 

30. The values of some cells are restricted. When you type something inadequate in some cells, 
a dialog box will pop-up and direct you to retry to enter the correct value or to cancel, as in 
the example below. 

 

31. When you type in some cells, they (and several others) may turn red. This means that you 
entered an incorrect number. You should check your data and re-enter the correct value. 
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IV.  Input the text of the test items in the tabulation file 

 
32. Open the Word file that includes the version of your pre-test where the correct answers end 

with “^” (as was mentioned in the guidelines on how to prepare the test forms point 17). 

33. Select and copy all pre-test items. 

34. Go to your Excel tabulation file.  

35. Click the sheet tab ”Blank sheet 1.” 

36. Click  to paste the values of the copied selection. 

37. Your test items may be split all over the sheet. In this Blank sheet, you will safely arrange 
them in the following way: 

WARNINGS! 
a. All items must be in column A only of a “Blank sheet”. 

b. Each element of the item must be in a different cell and one cell only. 

c. There must be no blank cells between the items. 

d. The stems (beginning of the test questions) must all start with their numbers. 

e. The response options must start with a. or b. etc., without item number or other character. 
f. The correct option (key) should end with ^. There should be nothing after ^, not even a dot, 

a space or any other character. 

Example of correct item layout 

 

a. All in column A only.
Column B is empty. 

b. One cell per stem or response option. 

c. No blank rows between items.d. Stems 
start with 
numbers. 

e. Options 
start with 
letters. f. Keys end with ^

a. On a Blank sheet.

http://siteresources.worldbank.org/WBIINT/Resources/How-to-prepare-test-forms.pdf
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TIPS! 

If you make a mistake, you can undo by pressing {Ctrl Z} together. 

It is faster to perform the same type of operations on all cells, then go back to the top and do 
another type of operation on all cells, etc. 

First, check if some text—that should be in one cell—is spread over several cells. If so, 
consolidate these cells. Go to the cell with misplaced text. Press F2 to edit this cell. Highlight and 
cut the content of the cell. Press Enter. Go to the cell where the text should be. Press F2 to edit it. 
Within the cell put your cursor where the text should be pasted. Paste the text. Press Enter.  

To create a paragraph break within a cell (see A7 in the example above), press the keys {Alt 
Enter} together. 

Besides the paragraph breaks, don’t bother formatting, sizing or wrapping the text in these cells. 
Format does not matter. The system will overwrite your formatting and create its own.  

Fix all misplaced text of all cells before moving to the next operations, i.e., deleting all 
empty/unneeded rows. 

To delete a row, put your cursor in the row to delete. Pull down the “Edit” menu, and select 
“Delete…” In the Delete dialog box, click “Entire row” then click “OK.” 

Put your cursor in the next row to delete. Press F4. (F4 repeats the last action.) Use this method 
without interruption, until the last unneeded row is deleted. (Only the clean list of items should be 
left in this sheet at this time.) 

Make sure that all item stems start with the question number with nothing, not even a space, a 
quote or a dot, before the number. 

Make sure that all response options start with the corresponding letter: a. b. c. d. or e. with 
nothing, not even a space, a quote or a dot, before the letter. 

Make sure that the correct answers end with ^ (and that nothing is typed after ^). Pressing F2 
automatically places the cursor after the last character of the cell. If you notice a space after ^, 
delete it. 

38. Your list of items should be clean and ready to be pasted where it will become operational. 

39. Highlight your full list of items, but nothing else!  You should not select any empty 
rows at the bottom of your item list. (Tip: Go to A1 and press the three keys {Shift Ctrl Down 
arrow} together.) 

40. Copy your highlighted list of items. 

41. Go to sheet “Pre Data.”  

42. Put your cursor on cell A5.  

43. Click .  
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44. Your pre-test items should be pasted in column A only. However, if the text is larger than the 
cell, it may appear in columns to the right. Your paragraph breaks may also seem to have 
disappeared. (See cell A11 in the picture below).  Don’t bother changing the layout, cell wrap, 
or other format. This layout will help you while your enter the data. Then, the template will 
automatically wrap the text in the final formatting stage.  

 

45. Click in a cell that is not highlighted to deselect the list of item.  

46. Save your file. 

47. Repeat all operations in Chapter IV for the post-test. The only differences are that you:  

a. Start with the Word file that includes the post-test (with correct answers showing) 

b. Paste and clean up the post-test items in “Blank sheet 2”; and 

c. Once they are clean, copy and paste their values in sheet “Post Data” cell A5. 

48. Save your file. 
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V.  Sort, match and number your test forms 

 
The course’s Learning Gain is computed on matched respondents, i.e., participants who 
answered both pre-and post-tests and whose answers to both tests could be matched by their 
codes. In this chapter, you will sort, match and number the forms in preparation for the data entry. 

49. Take all the (paper) test forms completed by participants to evaluate your course. 

50. Divide them in two piles: one with the pre-test and the other pile with the post-test. At all 
times during the sorting and tabulation, keep the pre- and post-test forms separate. 

51. Turn the pages to put the matching code on the top page of each test form. Participants 
should have written their codes on the first page of the pre-test. However, the code on the 
post-course questionnaire should be on the first page of the post-test that is after the Level-1 
evaluation form. Do not un-staple the forms yet.  

52. Sort the pre-test forms by alphabetic/sequential order of the participant code. If a participant 
did not write a code, put the form at the back of the pile. 

53. Repeat the sorting with the post-test pile of forms. 

54. Put both piles in front of you. Check if the code on the first pre-test form is the same as the 
code on the first post-test form. If it is, put the forms face down creating two additional piles.  

55. Check if the code on the second pre-test form is the same as the code on the second post-
test form. If it is, lay them face down behind the first test forms you checked. Repeat the 
operations until the bottom of the piles. 

What if the codes don’t match? 

a. If the codes of the top two forms don’t match, put the form with the first sequential code in a 
separate pile for unmatched forms. (The first sequential code could be either on the pre-test 
or the post-test.)  

b. Once you finished the piles, check all unmatched forms and try to match them in other ways: 

¾ Two forms may have about the same codes, and the same filling patterns and handwriting. If 
you are confident that they were answered by the same participant, change the code to make 
them identical and re-insert them in the piles of matched respondents. 

¾ Look at any comments any participants make. In addition to the codes and handwriting, some 
participants expressed the same ideas, sometimes in the same word on both forms.  

¾ If several participants used the same code, try to distinguish them through their handwritings 
or logical deductions (e.g., responses to demographic questions against the participant list). 
Then, add a –1 and –2 to their respective codes. 

c. Despite these tips, you may not be able to match all pre- and post-tests. If so, put the 
unmatched forms at the bottom of their respective pile of forms. 

56. For WBI Courses: Number each post-course form to associate the Level-1 evaluation and 
post-test answers for each participant: write 1 on each page of the first form, 2 on each page 
of the second form, etc. Then, separate the Level-1 evaluation forms (that WBIEG will 
process) from the post-test forms that you will tabulate. Tell WBIEG that the course was 
evaluated at Level-2. 
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VI.  Type the participant codes in your tabulation file 

 
57. Go to the sheet “Pre Data” on your Excel tabulation file and take your pre-test pile of forms. 

 IF YOU TYPE A MISTAKE IN THE SHEETS “PRE DATA” OR “POST DATA”, NEVER 
CUT AND PASTE; UNDO OR TYPE OVER INSTEAD. If you notice your mistake early, you 
could undo your last few operations: Press {Ctrl Z} together repeatedly. (These sheets are linked 
to other sheets that contain formulas to calculate your results. Cutting and pasting can change 
the cell references of linked formulas. Consequently, without being able to notice it, you could 
produce inaccurate results.) 
 
58. In row 3, type the codes that enable the pre-and post-tests to be matched for individual 

participants. Look at the pre-test file of forms and type the first participant code in cell B3. 
Type the next participant code in C3, etc. (See example below). Type the codes in the order 
in which you just matched the forms. The codes for the unmatched forms will be entered last.  

 

59. Go to the sheet “Post Data” and take your post-test pile of forms. 

60. In row 3, type the codes found on the post-test forms, in the same way as for the pre-test.  

 

 To match a respondent, type the same code in corresponding columns of the “Pre 
Data” and “Post Data” sheets. For example, if a participant had the code AM89, and if you 
typed AM89 in column B of the sheet “Pre Data,” you should type the same code AM89 in column 
B of the sheet “Post Data.” If you made a mistake in typing the code, the cell would turn red. 

What to do with the unmatched forms? 

a. Responses of unmatched respondents should also be typed. Some of the statistics use them. 

b. If you typed the code of unmatched respondents in the Pre Data sheet, we recommend that 
you leave the corresponding columns of the Post Data sheet blank. Start typing the codes of 
the unmatched post-test respondents in the columns to the right of those reserved for the 
unmatched pre-test respondents. Only if you don’t have enough columns, start re-using the 
same columns for the unmatched respondents. (If you reuse the same column for the pre-
and post-tests, the code numbers will turn red. Your results will still be accurate, but the 
layout may not be as clear.) 

61. Save your Excel file. 
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VII.  Type the participant responses 

 
62. Go to the sheet “Pre Data” on your Excel tabulation file and take your pre-test pile of forms. 

63. Click on the cell B6, i.e., the cell on the right of the first response option of the first item. 

64. Take the pre-test paper form with the code you typed on cell B3. All information you type in 
column B will be data from the participant with this code. 

65. Look at the respondent’s answer to the first pre-test question.  

¾ If the participant chose option a, type 1 in cell B6 and press {Enter}. If the {Enter} key does 
not put your cursor in the cell immediately below, press the {down arrow} key. 

¾ If the participant did not choose option a, type 0 in cell B6 and press {Enter}. If the {Enter} key 
does not put your cursor in the cell immediately below, press the {down arrow} key. 

66. In cell B7, type 1 if the participant chose the corresponding option b or 0 if s/he did not.  

67. Go to the cell immediately below and repeat the same operation. When you reach the end of 
the first item, skip the row with the stem of the item and go to the row corresponding to option 
a of the second item. It should be in B12.  

68. Type in the response to the second item, in the same way. Then, move to the next item, and 
the next, until the last item of the pre-test. Leave any unused rows at the bottom blank. Do 
not delete the blank rows. 

69. Take the pre-test form of the second respondent. Go to the next column (C). Check that the 
code typed in this column corresponds to the code on the paper form. Enter the responses of 
this participant in the same way. Then move to the next column, and the next, and repeat the 
same operations until the responses on all pre-test forms are typed.  

What if a cell turns red? 

The file flags issues in turning cells red. Red cells indicate one or several of the following cases: 

a. You typed 1 in the row reserved for a stem. If so, delete your response and type it where it 
belongs. 

b. You typed several 1 for a respondent to one item. Participants should have chosen only one 
response per item. If they selected several options, read the item and see if you could fix the 
answer logically. For example, a participant may have marked, a, b and c, but option d may 
be “all of the above” (equivalent to a, b, and c). In such case, type 1 in option d, and 0 in a, b, 
and c. If you can’t fix the response with this logic, type 0 for all responses of this respondent 
to this item.  

c. Some Toolkit directions were not followed. Your test may not have five response options for 
each item. The items may not have been laid out as explained in chapter IV above. In such 
cases, the red cells appear randomly even without data entry issues. Your results will still be 
accurate. However, you can’t rely on this safety feature to help you type the data accurately. 
So, ignore the color of the cells and pay extra attention to your data entry.  

70. Double-check all of the typed data against the paper forms and save your file. 

71. Go to the sheet “Post Data” and take your post-test forms. Repeat points 62-70. 
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VIII.  Launch the computation of your results, locate and print them 

 
72. Go to the sheet “Table.”  

73. Go to cell A1 and type in it the title of the course. Press Enter. The cell will turn white. 

74. In cell A2, type the course’s city, country, start and end dates, WB P0# and schedule code. 

75. In cell B4, type the number of participants in the course. (This may not be the same as the 
number of test forms, since some participants may not have answered.) 

76. In cell B5, type the number of items in the pre-test. 

77. In cell H5, type the number of items in the post-test. 

 If you get an error message resembling the picture below, the number of items that 
you typed is different from the number of items recognized by the system. 

 

If so, check if the number you typed is correct. If it is correct. Click Cancel. Go to the “Pre Data” or 
“Post Data” as asked in the box, and check that all test items have one and only one correct 
answer indicated with ^ at the very end of the correct answer. Add the missing ^, delete the extra 
^ or other characters that followed the ^, if any. 

Once done, go back to the sheet “Table” and re-enter the correct number of items. 

78. Click the Item Analysis macro icon  from your Toolkit toolbar. 

 
 
 

79. The following dialog box pops-up. If you entered all test answers of all respondents, click 
“Yes.” If you are missing a few forms, but want to get the temporary results, click “Yes.” 
Once you get the final forms, you’ll be able to enter them in this file and re-run the macro to 
get the final results. However, this macro is not meant to provide the results of only one 
participant or only one item, as the statistics provided apply to groups, not individuals. 
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80. The macro will run between one and five minutes, depending on the speed of your computer 
and whether you already ran the latest version of the macro before. You may work on 
something else while it runs. When the macro finishes to compute the results, the following 
dialog box pops-up. It gives you the location of your tabulation file and a new item analysis 
file (in the same directory as your tabulation file, with the same name except that “Item 
Analysis” was added). Click OK. 

 
 

81. The file with the Item analysis results will appear as in the example below. 

 

 



WBIEG: How-to-tabulate-responses.doc Page 14 of 17 March 6, 2005 

82. Print this sheet (typically 3 page long). The first page gives the item analysis of the pre-test. 
The second page of the post-test. The last page explains the numbers you see in these 
tables. Reviewing these numbers helps to understand the strengths and weaknesses of the 
course and of the test that was used to evaluate the course. 

83. Click the sheet tab “Additional Statistics.” Results as in the example below will appear. 

 

84. You may also print this sheet. It is set up automatically to print only one page. You don’t need 
to print the remaining numbers at the bottom of the sheet. 

85. To understand these statistics, click “Definitions” in cell B13. The following dialog box may 
pop-up. If so, click OK.  If not, go to 86. 

 

86. A one-page long PDF file with definition will open from the web. You may print this file. 
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87. Your tabulation file is still open. Click it. The results as in the example below appear.  

 

88. Click the icon  (on the Toolkit toolbar) to see the page break view. 

89. Scroll down until you see a blue line across the screen. The line may be full or dotted. This 
line indicates where the page breaks when you print your results. To read the results more 
easily, we recommend that you set the page breaks, so that the printout won’t cut an item into 
two pages. In the example below, the page will break in the middle of item 8. 

 

90. Click on the line and drag it up, just before the beginning of item 8. If dotted, the line will turn 
full. (This means that you manually set the page break.) 
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91. Keep scrolling down and setting the page breaks until the end of the document. 

92. Click  on the Toolkit toolbar to preview the results. If they are fine, print them.  

93. Return to the normal view by clicking  (from the print preview screen) or  
from the Toolkit toolbar. 

94. Click the web link in cell E8 “Other course results” to view a chart showing the distribution of 
learning gains of courses evaluated with the same method.  
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95. The chart below and the remaining information in the database are only accessible from the 
World Bank Intranet. You may print this chart if you wish. 

 
 

96. Congratulations! You have produced the tabulation of the results and the item analysis. If  
your course was sponsored by WBI, report the results (both files) to your course team, your 
Divisional Evaluation Coordinator, and to WBIEG. 

Contact: 
If you have any question, please contact the WBI Evaluation Help Desk at Ext.: 36430, or via 
e-mail at “WBI Evaluation Help Desk.” 
  

http://web.worldbank.org/WBSITE/EXTERNAL/WBI/0,,contentMDK:20270039~pagePK:209023~piPK:335094~theSitePK:213799,00.html

